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Important Information

Warranty
The FieldPoint hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective
during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF

NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR

DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY

THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire,
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

Trademarks
CVI™, FieldPoint™, LabVIEW™, Lookout™, National Instruments™, NI™, ni.com™, PXI™ are trademarks of National Instruments

Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to

pull down the File menu, select the Page Setup item, and select Options

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to

avoid injury, data loss, or a system crash. When this symbol is marked on

the product, see the FieldPoint Safety Information section for precautions

to take.

bold Bold text denotes items that you must select or click on in the software,

such as menu items and dialog box options. Bold text also denotes

parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction

to a key concept. This font also denotes text that is a placeholder for a word

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the

keyboard, sections of code, programming examples, and syntax examples.

This font is also used for the proper names of disk drives, paths, directories,

programs, subprograms, subroutines, device names, functions, operations,

variables, filenames and extensions, and code excerpts.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value

that you must supply.
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1
Overview of the FP-1601
Network Module

This chapter provides an overview of the FieldPoint FP-1601 network

module and FieldPoint software.

FP-1601 Hardware Overview

The FieldPoint FP-1601 network module connects a 10/100 Ethernet

network to FieldPoint I/O modules. Because the FP-1601 is an Ethernet

device, the maximum number of FP-1601 modules you install on your

Ethernet network is determined by your network topology. Each FP-1601

can support up to nine I/O modules.
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The FP-1601 has LED indicators to communicate status information, and

DIP switches that perform various functions. The following illustration

shows where these features are located on the FP-1601.

A FieldPoint bank consists of at least one network module, one or more

terminal bases, and one or more I/O modules. Each FP-1601 can support up

to nine I/O modules. You can access each bank by an unlimited number of

host computers or LabVIEW RT enabled devices (such as FP-2000/2010 or

PXI chassis). The maximum number of FP-1601 network modules that you

can install on your Ethernet network is limited only by your network

topology. With Ethernet, you can use an unlimited number of FieldPoint

banks.

The FP-1601 network module connects directly to a 10 Mbps or 100 Mbps

Ethernet network. The module auto-detects the speed of the connection and

configures itself accordingly.

The following figure shows an FP-1601 connected to an Ethernet network.

For detailed hardware specifications and cabling information, refer to

Appendix D, Specifications.
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FieldPoint Software Overview

Your FieldPoint software includes a configuration utility as well as server

and driver software for easy integration into application software packages.

These software components manage the low-level communications and

hardware details, simplifying programmatic access to I/O channels.

Version 3.0 of the FieldPoint software runs on Windows Me/98/95,

Windows 2000, or Windows NT version 4.0 (service pack 3 or later), and

includes the following components:

• FieldPoint Explorer configuration utility

• LabVIEW VIs

• LabWindows/CVI Functions

• OPC Server

• Lookout driver

You can download future versions of FieldPoint software from the National

Instruments FTP site at ftp.ni.com/support/fieldpoint/Server.

1 FP-1601 Network Module
2 Terminal Base
3 I/O Module

4 Ethernet Cable
5 Ethernet Hub/Switch
6 Ethernet Devices/Computers

1 2

3

5

66 6

4
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FP-1601 Setup Overview

The following list is an overview of the steps required to get up and running

with your FP-1601:

1. Install the hardware as described in Chapter 2, Hardware and Software

Installation.

a. Mount the FP-1601, terminal bases, and I/O modules.

b. Connect your FieldPoint system to the network.

c. Wire power to FieldPoint system.

d. Wire signals to the I/O modules.

2. Install the software as described in Chapter 2, Hardware and Software

Installation.

a. Install applications software.

b. Install FieldPoint Explorer.

3. Configure the FieldPoint system, and verify the configuration, as

described in Chapter 3, Hardware and Software Configuration.

a. Configure FP-1601 network settings.

b. Configure I/O module ranges and settings.

c. Configure security.

d. Test channels.

e. Save settings.

4. Deploy system.
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2
Hardware and Software
Installation

This chapter explains how to install your hardware and software.

What You Need to Get Started

To set up and use the FP-1601, you need the following:

❑ FP-1601 network module

❑ Mounting hardware (DIN rail or panel mount accessory)

❑ Terminal base(s) and I/O module(s)

❑ Power supply

❑ Accessories: Ethernet cable, screwdriver

❑ FieldPoint Software CD

❑ A host PC running Windows Me/98/95, Windows 2000,

or Windows NT version 4.0

FieldPoint Safety Information

This section contains important safety information that you must follow

during installation and use of FieldPoint products.

Do not operate your FieldPoint product in a manner not specified in the user

manual or operating instructions. Misuse of the product can result in a

hazard. You can compromise the safety protection built into the product if

the product is damaged in any way. If the product is damaged, return it to

National Instruments for repair.

Do not substitute parts or modify the FieldPoint product. Use the product

only with the modules, accessories, and cables specified in the installation

instructions.
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Always operate your FieldPoint product in a suitable enclosure that will

prevent unintentional access to live terminals and will prevent the spread of

fire.

Do not operate FieldPoint products in an explosive atmosphere or where

there may be flammable gases or fumes. If you need to operate FieldPoint

products in such an environment, the FieldPoint products must be in a

suitably rated enclosure. Operate the product only at or below Pollution

Degree 2. Pollution is a foreign matter in a solid, liquid, or gaseous state

that can produce a reduction of dielectric strength or surface resistivity. The

following is a description of pollution degrees:

• Pollution Degree 1 means no pollution or only dry, nonconductive

pollution occurs. The pollution has no influence.

• Pollution Degree 2 means that only nonconductive pollution occurs in

most cases. Occasionally, however, a temporary conductivity caused

by condensation must be expected.

• Pollution Degree 3 means that conductive pollution occurs, or dry,

nonconductive pollution occurs, which becomes conductive due to

condensation.

If you need to clean a FieldPoint product, use a soft nonmetallic brush.

The product must be completely dry and free from contaminants before

returning it to service.

You must insulate signal connections for the maximum voltage for which

the FieldPoint product is rated. Do not exceed the maximum ratings for the

product. Do not install wiring while the product is live with electrical

signals. Do not remove or add terminal bases when power is connected to

the FieldPoint system. Avoid contact between your body and the terminal

base signal wiring when hotswapping modules.

Operate FieldPoint products at or below installation category II. The

following is a description of installation categories:

• Installation Category I is for measurements performed on circuits not

directly connected to MAINS1. This category is a signal level such as

voltages on a printed wiring board (PWB) on the secondary of an

isolation transformer.

Examples of Installation Category I are measurements on circuits not

derived from MAINS and specially protected (internal)

MAINS-derived circuits.

1 MAINS is defined as the electricity supply system to which the equipment concerned is designed to be connected for either
powering the equipment or for measurement purposes.
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• Installation Category II is for measurements performed on circuits

directly connected to the low-voltage installation. This category refers

to local-level distribution, such as that provided by a standard wall

outlet.

Examples of Installation Category II are measurements on household

appliances, portable tools, and similar equipment.

• Installation Category III is for measurements performed in the building

installation. This category is a distribution level, referring to

hard-wired equipment that does not rely on standard building

insulation.

Examples of Installation Category III include measurements on

distribution circuits and circuit-breakers. Other examples of

Installation Category III are wiring including cables, bus-bars, junction

boxes, switches, socket-outlets in the building/fixed installation, and

equipment for industrial use, such as stationary motors with a

permanent connection to the building/fixed installation.

• Installation Category IV is for measurements performed at the source

of the low-voltage (< 1,000 V) installation.

Examples of Installation Category IV are electric meters, and

measurements on primary overcurrent protection devices and

ripple-control units.

Mounting the FP-1601 and Terminal Bases

You can mount your FieldPoint system either to a DIN rail or directly on

a panel. Panel mounting is generally the more secure option, but DIN rail

mounting might be more convenient for your application. The following

sections give instructions for both mounting methods.

Electric
Meter

Circuit
Breaker

Plug-in
Equipment

CAT IV CAT IIICAT IVCAT IV CAT II CAT I

Source of
Low-Voltage
(<1000V)
Installation

Building/Fixed
Installation
Distribution

Panel

Local-Level
Distribution, Such
as Wall Sockets

Secondary
Windings of
Isolation

Transformers
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Mounting the FP-1601 on a DIN Rail
The FP-1601 network module has a simple rail clip for reliable mounting

onto a standard 35 mm DIN rail. Follow these steps if you choose to mount

the module on a DIN rail:

1. Write down the serial number from the back of your FP-1601 before

you mount it.

2. Use a flat-bladed screwdriver to open the DIN rail clip to the unlocked

position, as shown in the following illustration.

3. Hook the lip on the rear of the FP-1601 onto the top of a 35 mm

DIN rail and press it down onto the DIN rail, as shown in the following

illustration.

4. Slide the FP-1601 to the desired position along the DIN rail. After it is

in position, lock it to the DIN rail by pushing the rail clip to the locked

position, as shown in the following illustration.

1 Rail Clip Locked 2 Rail Clip Unlocked

1 2
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After the FP-1601 is mounted to the DIN rail, connect the terminal base

to it.

Connecting Terminal Bases with DIN Rail Mounting
Follow these steps to connect a terminal base to an FP-1601 network

module using DIN rail mounting.

Caution To avoid damaging the FP-1601 and the terminal bases, make sure that power

is not applied to them while you install or remove terminal bases.

1. Mount the terminal base onto the DIN rail in the same way you

installed the network module.

2. Attach the terminal base to the FP-1601 by firmly mating the local

bus connectors. Be careful not to bend any pins.

3. To add more terminal bases, install them on the rail and connect their

local bus connectors together. In most cases a single FP-1601

can support up to nine terminal bases, depending on the power

consumption of the I/O modules. Refer to the Wiring Power to Your

FieldPoint System  section of this chapter for more information about

power requirements.
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4. Place the protective cover onto the local bus connector of the last

terminal base on the bank, as shown in the following illustration.

Add the rail locks by sliding them on and tightening the screws.

Removing the FP-1601 and Terminal Bases from the
DIN Rail
Remove an I/O module from its terminal base before lifting the terminal

base off the rail. To remove an FP-1601 network module or terminal base,

unlock it from the DIN rail by placing a screwdriver in the slot on the rail

clip and opening it to the unlocked position. After you disconnect the

network module from the local bus connector of the terminal base, you can

lift it off the rail.

Mounting the FP-1601 to a Panel
Follow these steps if you choose to install the optional FieldPoint network

panel mount accessory and mount the FP-1601 network module to a panel.

You can order the panel mount accessory, part number 777609-01,

from NI.

1. Write down the serial number from the back of your FP-1601 before

you mount it.

2. Use a flat-blade screwdriver to open the rail clip to the unlocked

position, as shown in the following illustration.

1 Rail Clip Locked 2 Rail Clip Unlocked

1 2
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3. Snap the panel mount accessory onto the module, as shown in the

following illustration.

4. Lock the panel mount accessory into place by pushing the rail clip to

the locked position.

5. Mount the FP-1601 to your panel with the panel mount accessory, as

shown in the following illustration. The installation guide that came

with the panel mount accessory includes a template that you can use to

drill pilot holes for mounting.
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Connecting Terminal Bases with Panel Mounting
You can install terminal bases directly, without using the panel mount

accessory needed to mount the FP-1601 network module. Follow these

steps to connect terminal bases to the network module using panel

mounting.

Caution To avoid damaging the FP-1601 and the terminal bases, make sure that power

is not applied to them while you install or remove terminal bases.

1. Drill pilot holes in the panel to mount the terminal bases. A drilling

template is provided with the network module panel mount accessory.

2. Connect the terminal base to the FP-1601 by firmly mating the local

bus connectors. Be careful not to bend any connector pins.

3. Bolt, screw, or otherwise fasten the terminal base to the panel. Make

sure that the local bus connectors remain firmly mated after the

terminal base is mounted.

4. To add more terminal bases, repeat steps 1 through 3, mating the local

bus connectors of each new terminal base to the connector of the last

installed base. In most cases a single FP-1601 can support up to

nine terminal bases, depending on the power consumption of the I/O

modules. Refer to the Wiring Power to Your FieldPoint System    section

of this chapter for more information about power requirements.

If all the pilot holes were drilled correctly, the local bus connectors

should remain firmly mated after all the bases are mounted to the

panel.
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5. Place the protective cover onto the local bus connector of the last

terminal base on the bank, as shown in the following illustration.

Removing the FP-1601 and Terminal Bases from
the Panel
To remove an FP-1601 network module and terminal bases from the panel,

first remove the terminal bases, starting with the last one, then remove the

network module.

Mounting I/O Modules onto Terminal Bases

Generally, it does not matter where you install each I/O module, except for

these types of situations:

• If you plan to cascade power between any I/O modules using the V and

C terminals, group those modules together.

• For more accurate measurements, locate any thermocouple modules

away from heat sources, including network modules or relay modules,

unless you are mounting them on an FP-TB-3.
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Refer to the following illustration and follow these steps to connect an I/O

module to a terminal base:

1. Position the first module with its alignment slots aligned with the guide

rails on the terminal base.

2. Firmly press the module onto the terminal base. The terminal base

latch locks the I/O module into place when the ejector button pops up

on top of the terminal base.

3. Repeat this procedure to install additional I/O modules onto terminal

bases.

To remove a module, press the ejector button on top of the terminal base

and pull off the module.

Note Some older modules may require more force to remove them from the terminal base.

Make sure you firmly pull the module straight off the terminal base.

Connecting Your FP-1601 to the Network

Connect the FP-1601 network module to an Ethernet network using the

RJ-45 Ethernet port on the module. Connect the RJ-45 Ethernet port of the

module to an Ethernet hub using a standard Category 5 Ethernet cable. You

can also connect the module directly to a computer using an Ethernet

crossover cable.

Caution To prevent data loss and to maintain the integrity of your Ethernet installation,

do not use a cable longer than 100 m. If you are using a 100 Mbps Ethernet,

NI recommends using a Category 5 shielded twisted-pair Ethernet cable.
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The following illustration shows the FP-1601 connected to an Ethernet hub.

The following illustration shows the FP-1601 connected directly using a

crossover cable.

The host PC communicates to the FP-1601 over a standard Ethernet

connection. If the host PC is already configured on a network, you must

configure your FP-1601 on the same network. If neither is connected to a

network, you can connect the two directly using a CAT-5 crossover cable.

If you need to build your own cable, refer to Appendix D, Specifications,

for more information about Ethernet cable wiring connections.

In order to configure the FP-1601, it must reside on the same subnet as your

host PC. If you want to use the FP-1601 on a subnet other than the one your

host PC is on, first connect and configure it on the same subnet as the host

PC, then reassign a static IP address for the subnet where you want it to be

and physically move it to the other subnet. Contact your network

administrator if you need assistance configuring the host PC and FP-1601

on the same subnet.

Wiring Power to Your FieldPoint System

Each FP-1601 on your network requires a 12-30 VDC power supply. The

FP-1601 filters and regulates this supplied power and provides power for

all the I/O modules in the bank. Therefore, you do not need to provide
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power separately to each FieldPoint I/O module in the bank. Follow these

steps to connect power to your FieldPoint system:

1. Connect 12-30 VDC power supply leads to the V and C terminals of

the network module. Connect the positive lead to V and the negative

lead to C. To verify that your power supply is sufficient for your

modules and devices, refer to the Calculating Power for a FieldPoint

Bank section for instructions on calculating power requirements.

2. Connect power to the FieldPoint modules that require external power

for inputs or outputs (may include output modules, counter modules,

PWM, PG, and QUAD). Refer to the I/O module’s operating

instructions for power requirement details. You can power a module by

connecting the V and C inputs on its terminal base to a separate power

supply, connecting the V and C outputs of a neighboring terminal base

or network module, or using a combination of both methods. If you

want to power field I/O devices from a terminal base, supply power to

the terminal base, and then connect the terminal base V and C output

terminals to the field device.

Caution Cascading power from neighboring bases or network modules defeats isolation

between cascaded modules.

The following illustration shows an example of a FieldPoint system

correctly wired to power sources.

1516 V

31 32 C

V 1 32

C17 18
CAUTION: Cascading
power defeats isolation.

Shades of gray indicate
different voltage potentials.

FP-TC-120FP-RLY-420FP-AO-200FP-AI-100FP-1601

Separate Power Supply
(Recommended)

Cascaded Power
(Reduces Isolation)

No External
Power Required
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Calculating Power for a FieldPoint Bank
The power requirements for a FieldPoint bank that uses an FP-1601

network module are calculated as follows:

Power = 4.5 Watts + 1.1 * ∑(I/O Module Consumption)

This is the amount of power the FP-1601 network module consumes from

the power supply to power itself and the I/O modules. It does not include

any power consumed by devices that you wire to the terminal bases.

The FP-1601 supplies 9 W of power to the I/O modules. Using certain

I/O modules that consume more than 1 W can reduce the total number

of I/O modules allowed in the bank to less than nine. Refer to the operating

instructions for each I/O module for power consumption information.

Connecting to Field Devices

Use each I/O module’s operating instructions, or the diagram under its

removable label, to help you connect your field devices.

Powering Up the FP-1601

Plug in each power supply to your FieldPoint bank. At power up, the

FP-1601 runs a power-on self test (POST) that takes several seconds.

You should see the POWER and STATUS LEDs come on. After about

5 seconds, the STATUS LED begins flashing one flash at a time. This

indicates that the FP-1601 is ready for configuration, and you can proceed

to installing the FieldPoint software.

If you have already assigned an IP address to the FP-1601, the STATUS

LED turns off. When the I/O module READY LEDs come on, the FP-1601

is ready for use.

If the STATUS LED does not light as described, refer to the STATUS LED

Error Indications  section in Appendix C, Troubleshooting.



Chapter 2 Hardware and Software Installation

FP-1601 User Manual 2-14 ni.com

Installing Software on the Host PC

Follow these steps to install your FieldPoint software on the host PC:

1. Install the software packages you plan to use, such as LabVIEW,

Lookout, or LabWindows/CVI, before you install your FieldPoint

software. The FieldPoint software installation installs the LabVIEW

VIs and examples, Lookout driver class for use with serial FieldPoint

modules, and LabWindows/CVI instrument driver only if it finds the

corresponding development software installed.

2. Close all other applications.

3. Insert the FieldPoint software CD into the CD-ROM drive on your

computer.

4. Follow the onscreen instructions to complete the installation.

Note If the setup does not launch automatically, select Start»Run from Windows,

enter d:\setup, where d is the letter of your CD-ROM drive, and select OK.

The hardware and software installation is now complete. Proceed to

Chapter 3, Hardware and Software Configuration.
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3
Hardware and Software
Configuration

This chapter describes the details of configuring hardware and software,

verifying the configuration, and accessing the channels on the FP-1601

from other software running on the host PC.

Configuring the FP-1601 in FieldPoint Explorer

To get started with FieldPoint Explorer, follow these steps:

1. Make sure that the FieldPoint hardware and software is installed as

explained in Chapter 2, Hardware and Software Installation. Verify

that the FieldPoint system is powered on.

2. From the Windows Start menu, select Programs»National

Instruments FieldPoint»FieldPoint Explorer to launch FieldPoint

Explorer, shown in the following illustration.

3. Click the + sign next to IA Server with OPC in the left panel to

expand the view. Right-click FieldPoint and select Add a comm

resource to this server. The Comm Resource Configuration dialog

box appears.



Chapter 3 Hardware and Software Configuration

FP-1601 User Manual 3-2 ni.com

4. To use the FP-1601, set the Type to Ethernet, as shown in the

following illustration. Each Ethernet comm resource represents a

single bank of FieldPoint modules on the network.

5. Click Browse to launch Remote System Explorer, shown in the

following illustration.

Remote System Explorer launches and searches for any FP-1601 or

other NI Ethernet devices on the subnet. The serial number shown

corresponds to the serial number of your FP-1601. The status of the

module is Unconfigured because you have not yet set the IP address

for it.
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6. Double-click the serial number of the FP-1601 you want to configure.

(You can also right-click the network module and choose Configure

Device to launch this dialog box.)

7. Enter values on the Network Settings tab of the System

Configuration dialog box, shown in the following illustration. Refer

to Appendix A, Choosing Network Settings, for more information

about choosing appropriate addresses for these fields. You can also

click Suggest Values to let the software provide default parameters.

If your network does not have a gateway server or DNS server, set

these parameters to 0.0.0.0.

• IP Address—the unique, computer-readable address of a device

on your network. An IP address is typically represented as four

numbers separated by periods (for example, 130.164.55.112)

where the numbers can be between 0 and 255, inclusive.

• Subnet Mask—a code that helps the network device determine

whether another device is on the same subnet or a different subnet.

The most common subnet mask is 255.255.255.0.

• Gateway—the IP address of a device that acts as a gateway server,

which is a connection between two networks.

• DNS Address—the IP address of a network device that stores host

names and translates them into IP addresses.
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8. On the System tab of the System Configuration dialog box, enter a

comment to help you identify your FP-1601. For example, you could

identify your FP-1601 module as Station 4 as shown in the

following illustration.

9. Enter an IP address for the Time Server on the Servers tab of the

System Configuration dialog box, shown in the following illustration.

The Time Server is a networked computer that runs the NI Time

Service. This is usually one of the computers that runs FieldPoint

software. The FP-1601 has a battery-backed internal clock that

provides accurate time stamps in the absence of a Time Server.

However, the FP-1601 must contact a time server at least once to set

the internal clock initially.
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10. Click OK in the System Configuration dialog box. The FP-1601

reboots automatically.

After the FP-1601 has rebooted, you should see it in Remote System

Explorer with the updated IP address and comment, as shown in the

following illustration. If you do not, select View»Refresh. Or, refer to

the FP-1601 Does Not Appear in Remote System Explorer Dialog

when Browsing section of Appendix C, Troubleshooting.

11. Highlight the module and click the Select button. When the new host

name or IP address appears in the Comm Resource Configuration

dialog box of FieldPoint Explorer, you can proceed to configuring your

devices and channels.

Finding and Configuring Devices and Channels

After you have configured the FP-1601 in FieldPoint Explorer, follow

these steps to configure your FieldPoint devices and channels:

1. In the Comm Resource Configuration dialog box, click Find

Devices to search for all of the FieldPoint devices on this

communications resource. (If the Comm Resource Configuration

dialog box is not already open, right-click your Comm Resource in

FieldPoint Explorer and select Edit this comm resource.)

If no devices are found, refer to the No Modules Found Error in

FieldPoint Explorer section in Appendix C, Troubleshooting.
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2. After the FieldPoint modules are found, click on the + sign next to

FP Res in the left pane to expand the device hierarchy and display the

modules found on the network, as shown in the following illustration.

The hierarchy includes all of the modules connected to the FP-1601.

The default name of each device found includes the name of the

FieldPoint module, followed by a space, the @ sign, and the address of

the module (for example, FP-1601 @0). For each module found,

one I/O item is created for each channel on the module, and if all the

channels are of the same type, one I/O Item is created to represent all

the channels on that module collectively.
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3. To configure the hardware settings of a particular I/O module,

right-click the device name and select Edit this device. The Device

Configuration dialog box appears, as shown in the following

illustration.

For output modules, you can choose settings for Watchdog

Configuration. Refer to the Guarding Against Network Failures

(Network Watchdog) section in Chapter 4, Feature Set Description,

for more information about the network watchdog feature.

4. Click the Channel Configuration button to access the Channel

Configuration dialog box. In the following illustration, an FP-TC-120

thermocouple module is selected.
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Note Configuration options are module-dependent. The options listed here might not be

available for your particular module.

Make your selections in this dialog box as follows:

a. Select the type of channel to show, then checkmark the channel(s)

that you want to change. To select more than one channel, uncheck

the One channel at a time box.

b. Set the range and output values of the selected channel(s).

c. Set the deadband for data communication over the network.

The deadband setting is a percentage of the full-scale range.

d. Set the attributes for the selected channel(s) by selecting the

attribute and entering the desired value.

e. Send commands to the selected channel(s) by choosing a

command and value and clicking Send.

f. Repeat this procedure for each channel you want to configure.

g. Click OK, or click Apply to save the changes and continue to

configure channels. When you click OK or Apply, the changes are

immediately sent to the device and saved in its non-volatile

memory.
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Saving Hardware Configuration as Power-Up State

When you are satisfied with the hardware configuration of your FieldPoint

system, you can save this configuration as the new power-up state for

the bank.

1. Right-click on the FP-1601 network module in the left pane of

FieldPoint Explorer, and select Edit this device.

2. Deselect the factory configuration checkbox.

3. Specify the power-up settings with either of the following options:

• If you want only the range and attribute settings you configured in

the Finding and Configuring Devices and Channels section saved

as power-up states, click the OK button. These settings are written

to the non-volatile memory of the network module.

• If you want to save power-up values for the range and attribute

settings and also all the current output states of the output

channels, click Snapshot. This stores the current ranges,

attributes, and output values of that bank of FieldPoint modules to

the power-up memory of the network module. Click OK when

you are finished.

Caution Using the Snapshot feature overwrites any power-up values you may have

specified for individual channels in the Channel Configuration dialog box.

Refer to the Storing a Custom Power-Up Configuration section in

Chapter 4, Feature Set Description, for more information about

configuring and changing the power-up values. Refer to the Guarding

Against Network Failures (Network Watchdog)   section of Chapter 4,

Feature Set Description, for information about configuring a network

watchdog to guard against network failures.
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Using Other Features and Options in Remote
System Explorer

You can access Remote System Explorer by right-clicking the comm

resource in FieldPoint Explorer, selecting Edit this comm resource, then

clicking the Browse button. You can use the Remote System Explorer

toolbar buttons, Tools menu, or right-click menu to access the following

features:

• Configure Device—use to configure the IP address, comment,

and other parameters for the selected FP-1601.

• Reboot Device—use to reboot the selected FP-1601.

• View Installed Software—use to view driver software versions

installed on the selected FP-1601.

You can use the Remote System Explorer toolbar buttons or View menu to

access the following features:

• Large icon view—changes the view in the main window to large

icons.

• Small icon view—changes the view in the main window to small

icons.

• List view—changes the view in the main window to a list.

• Detailed view—changes the view in the main window to a list with

additional information such as serial number, IP address, status,

model, and comment.

• Refresh Browse List—refreshes the list of FP-1601 modules and

other National Instruments Ethernet devices found on the local subnet

or at the specified IP address. Changes to IP address, comment, and so

on do not appear in Remote System Explorer until you reboot the

selected system and click the Refresh Browse List button.
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Setting up Security for the FP-1601

You can set network security options to limit host access and you can lock

the settings made in Remote System Explorer.

Configuring Network Security
You can limit host access to the FP-1601 by setting access permissions for

different host machines. The default setting allows Read/Write access to all

host machines. To change the network security settings, follow these steps:

1. Right-click the Comm Resource in FieldPoint Explorer and select

Edit this comm resource. The Comm Resource Configuration

dialog box appears with the Network Security button enabled.

2. Click the Network Security button. The Network Security Settings

dialog box appears with the current settings, as shown in the following

illustration. If your host machine does not have access to the FP-1601,

the Access List is empty and grayed out.

3. Make your additions or changes in the dialog box, as follows:

• If you have an IP Access List saved in a file or you want your

FP-1601 security settings to match another FP-1601 unit, you can

import those settings by clicking on the Import checkbox. Then

select the source (from file or from device). The settings read

from the source are shown in the Access List for you to modify,

if needed.

• To add a host machine to the list, enter its IP address in the IP

Pattern edit box, select the desired access type (Read/Write, Read

Only, or Deny Access) from the Access Type list, then click the
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Add button. You can use the * wildcard when specifying the IP

address. For example, to give Read/Write access to all hosts,

enter * in the IP Pattern edit box, or to Deny Access to all

machines on the 111.222.333 subnet, enter 111.222.333.* in the

IP Pattern box.

• To remove a host machine from the list, either click the entry or

type the entry in the IP Pattern box, then click the Remove button

or press the <Delete> key.

Note Once you modify the list, any IP Address that does not have any matching entry is

denied access to the FP-1601.

• To change the order of the entries in the list, select an entry and

click the up arrow or down arrow button that is located next to the

Access List. A new entry is always added to the end of the list.

You can have multiple matching entries for a given IP address.

In that case, the first entry that matches the IP address is used,

starting from the bottom of the list.

• To save the IP Access List to a file to be used for other FP-1601

modules, click the Save checkbox and enter a file name.

4. Once you are satisfied with the changes, click OK. A dialog box

appears, prompting you for the password. After you enter the password

and click OK, your changes are applied to the FP-1601.

Verifying the Configuration

You can try to monitor an I/O channel or write to an output channel from

FieldPoint Explorer, to verify your installation and configuration.

Monitoring an I/O Channel
You can monitor FieldPoint devices that you have configured. In the left

pane of FieldPoint Explorer, select one of the devices, then click the green

arrow icon in the toolbar to start monitoring the items of that device.

The tag symbols of the items in the list view pane turn blue to show that

they are being monitored. As shown in the following illustration, the Value

column shows the current value of the I/O channels defined by the

I/O Items, and the Status column shows any error conditions received

while communicating with the FieldPoint network. Timestamp is the time

when the FP-1601 made the value available to the host PC.
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Click the red square icon in the toolbar to stop monitoring the items.

Writing to an Output Channel
You can write to output channels of I/O Items that you have configured.

1. In the left pane of FieldPoint Explorer, select a device with output

channels.

2. Select the I/O item in the right-side pane that corresponds to

the channel to which you want to write.

3. Click the pencil and paper icon in the toolbar to write to the I/O

channel(s) represented by the I/O item.

4. Enter the value you want to write in the Value field and click the Write

button to write the value out. The value must be in the range of the

channel that you configured in step 4 of the Finding and Configuring
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Devices and Channels section in this chapter. For example, if the

channel was configured for a range of 0.0035 to 0.021 A, and you want

to write a value of 0.010 A (10 mA), enter 0.010 in the Value box. For

discrete I/O channels with a Boolean range, enter a 1 or a 0 in the

Value field.

Using the FP-1601 from Host Applications

The following sections explain how to access the channels on the FP-1601

from software running on the host PC.

Lookout and the FP-1601
The FP-1601 network module integrates easily with National Instruments

Lookout 4.0 and later. You can access the module the same way you would

access another desktop computer running Lookout. You can access the

channel data, ranges, attributes, and commands from Lookout, as well as

several control variables, such as Reset and Snapshot.

To access the FP-1601 with Lookout 3.8 or earlier, use the FieldPoint OPC

server. You cannot use the FieldPoint 3.8 Lookout driver class with the

FP-1601.

To use the FP-1601 with Lookout 4.0 or later, follow these steps:

1. Configure your FP-1601 from FieldPoint Explorer, as described in the

Configuring the FP-1601 in FieldPoint Explorer    section of this

chapter.

2. Start Lookout, and create a new process or open an existing one.

3. Register the FP-1601 as a networked computer in Lookout. Select

Object»Object Explorer or Object»Connection Browser from the

menu bar and right-click on the Network icon. Choose Register

network computer from the pop-up menu. Type the IP Address or

host name of the FP-1601 in the Computer name field and click OK.

4. When you create a Lookout object or expression, you can connect it to

data on the FP-1601 network module. In the Insert Expression dialog

box, click Network to browse the registered computers and FP-1601

modules. Click the IP address or host name of the network module and

browse to the desired data.

An alternative method is to use the fpoint.cbx to access the channel data.
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LabVIEW VIs and the FP-1601
When you install the FieldPoint software, a library of FieldPoint VIs is

created if LabVIEW has already been installed on your computer. The

FieldPoint VIs (FP Open, FP Get Configuration Info, FP Create Tag,

FP Advise, FP Read, FP Write, and FP Close) directly access the I/O Items

you configured in the FieldPoint Explorer program. For help using these

VIs, refer to the examples in the LabVIEW\examples directory or use the

FieldPoint LabVIEW Help, which is in the same program group on your

Windows taskbar as FieldPoint Explorer. You can use this same set of VIs

to access the FP-1601 from the host PC. A simple FieldPoint application to

read an I/O item might only need to use four of the VIs. To create an

example of such an application, complete the following steps:

1. Use FP Open to open the server. By default, the server opens with the

configuration file you last saved with FieldPoint Explorer.

2. Use FP Create Tag to create a handle to an I/O item that you defined

in FieldPoint Explorer. You provide three string names to this VI to

indicate which I/O item you want to access. These three strings are

the names given to the communications resource, the device, and the

I/O item.

Note The strings provided to the VI must exactly match the names in FieldPoint Explorer,

including spaces and letter case.

3. Use FP Read.vi to monitor an I/O item. You should also add a delay

into the loop so that the loop operates at your desired rate. Otherwise,

it can load the processor at 100% and lock the software in the module.

To write to an Output Item, use FP Write instead of FP Read.

Note You can use FP Advise in place of FP Read. However, it is best not to place anything

else in a while loop with FP Advise. When using FP Advise.vi, you can configure its timing

as an input to the VI. Also, do not put more than one FP Advise VI in a loop. All VIs in a

loop execute only once each time a loop runs, and FP Advise VIs only complete at their

advise rate. If you had more than one FP Advise VI in the loop, the loop (and therefore all

of the FP Advise VIs in the loop) would only execute at the slowest rate of the Advises.

The loop might not execute more than once if any of the Advises is set to complete “On

Data Change” and the data of the corresponding I/O item never changed.
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4. Use FP Close to close the server. This action also stops all pending

advise operations.

5. The following illustration gives an example of a LabVIEW diagram

with FieldPoint items.

LabWindows/CVI Functions and the FP-1601
When you install the FieldPoint software, a LabWindows/CVI instrument

driver for FieldPoint is installed if LabWindows/CVI has already been

installed on your computer. This instrument driver includes function panels

to call C functions that directly access the I/O Items you configured in the

FieldPoint Explorer program. In addition, a set of sample projects is placed

in your LabWindows/CVI Samples directory. Using these examples is

the best way to get familiar with these functions. The FieldPoint CVI Help

document is in the same program group on your Windows taskbar as the

FieldPoint Explorer program. This help document describes each function

in the instrument driver with a description of the C syntax, a description of

each parameter, and a list of possible error codes.

Note FieldPoint CVI Interface Compatibility Modes—The FieldPoint software ships

with object (.obj) files to support the different compiler compatibility modes that

LabWindows/CVI supports (Microsoft Visual C/C++, Borland, Watcom, and Symantec).

When the FieldPoint software is installed, the .obj file corresponding to the configured

compatibility mode is installed.
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FieldPoint OPC Server and the FP-1601
The FieldPoint OPC server conforms to the OPC Data Access 2.0 standard.

OPC (OLE for Process Control) is an industry standard device interface

specification that provides interoperability between field devices such as

FieldPoint and application software packages. The FieldPoint OPC server,

like the other FieldPoint interfaces, imports the I/O Items that you

configured in FieldPoint Explorer and makes them available as OPC Items

to any OPC client. Therefore, if two computers are networked together,

it is possible for an OPC client on one computer to access FieldPoint

hardware connected to the OPC server on another computer.

OPC clients might differ in the features they offer and their presentation

of the OPC interface for the FieldPoint OPC server. Refer to the

documentation on using the OPC client features of your application for

detailed instructions on how to access an OPC server. However, the basic

steps involved are similar for most OPC client applications.

Follow these steps to use the FieldPoint OPC server:

1. Launch your OPC client.

2. Open the FieldPoint OPC server, National 

Instruments.OPCFieldPoint, from the OPC client.

This server was registered with Windows when you installed the

FieldPoint software. OPC clients should be able to show you a list

of available registered servers, but you might have to type this name

in yourself. The OPC client might automatically connect to the server

when you select it, but if you are given the option to explicitly connect

to the FieldPoint OPC server, you should do so.

3. Create a group.

Groups are a collection of I/O Items. Some OPC clients might not give

you the option of creating groups, or they might be created for you.

4. Select the I/O Items, which you configured in FieldPoint Explorer, that

you want to read or write as a part of this group.

Many OPC clients can use the Browse Address Space feature of

the FieldPoint OPC server to show you a list of all of the I/O Items

you configured in FieldPoint Explorer. However, if the OPC client you

are using does not support this feature, you might need to type the Item

IDs of the I/O Items directly. The naming convention of the FieldPoint

Item IDs is Comm resource name\Device Name\I/O Item name
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where the Comm resource name, Device name, and I/O Item name are

the names given in FieldPoint Explorer. For example, an Item ID

associated with one of the I/O Items might be the following:

FP Res\FP-TC-120 @1\Channel 0

In most cases, the preceding steps are all that is required to configure an

OPC client to read from I/O Items of the FieldPoint OPC server. In some

cases, the OPC client might require more information about the FieldPoint

OPC server. The following list contains additional information about the

FieldPoint OPC server, which you might find helpful.

• The FieldPoint OPC server does not require an access path. Some OPC

clients might expect the access path to be included in the Item ID name

or might request the access path when you select I/O Items. You should

be able to leave the access path blank (empty string).

• The FieldPoint OPC interface is an out-of-process server.

• The FieldPoint OPC server supports both synchronous and

asynchronous reads and writes.

• The FieldPoint OPC server uses the GetErrorString method to return

error and diagnostic messages from the FieldPoint server and

hardware. OPC clients that do not support this method might give you

error messages like “Bad, non-specific” along with an error code.

Some OPC clients that do not support this GetErrorString method

might still provide a way for you to manually look up the FieldPoint

message corresponding to the error code using the method.
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4
Feature Set Description

This chapter describes the feature set for the FP-1601 network module.

Guarding Against Network Failures (Network Watchdog)

The network watchdog feature of the FP-1601 enables you to guard your

system against failures in the network connection, cables, or host computer.

If the network watchdog is enabled and the FP-1601 loses communication

with all hosts or clients over the network, the FP-1601 sets its output

channels to your pre-defined values (the watchdog state). So in cases where

you are running embedded applications on the FP-1601 that do not require

communication with a host computer or clients, the network watchdog

might not be appropriate.

Network watchdog output values can be different than power-up output

values. For example, you might want to turn an output value on when you

power up, but turn it off if network communication is lost.

By default, the network watchdog for the bank is disabled on power up.

To enable the network watchdog, follow these steps:

1. In FieldPoint Explorer, right-click on an output module and select Edit

this device.

2. Choose Enable or Enable on Use for the current watchdog

configuration.

3. Click the Channel Configuration button, then configure these

settings:

• Enable/disable the watchdog for each channel.

• Enter a watchdog data value for each channel.

4. Click OK.
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5. In the left pane of FieldPoint Explorer, right-click on the FP-1601,

select Edit this device, and configure these settings:

• Uncheck the factory configuration checkbox.

• Enable network watchdog for the bank.

• Enter a network watchdog timer value for the bank, a value that

specifies the maximum allowable period of lost communication

with hosts or clients over the network.

6. Click OK.

7. Select File»Save.

Storing a Custom Power-Up Configuration

Setting a Power-Up State with the Snapshot Method
The Snapshot feature provides a single-step method for storing the current

state of your FieldPoint hardware for use as the power-up state of the bank.

Caution Using the Snapshot feature overwrites any power-up values you may have

specified for individual channels in the Channel Configuration dialog box.

1. Set the hardware to the state you want to use as a power-up state,

including output values, ranges, and attributes.

2. Right-click on the FP-1601 network module in the left pane of

FieldPoint Explorer, and select Edit this device.

3. Deselect the factory configuration checkbox.

4. Click the Snapshot button. Click Yes and OK to approve the change.

5. Click OK in the Device Configuration dialog box.

6. Select File»Save.

At a later time, you might want to change the power-up values of an

individual channel. To make this kind of incremental change, use the

procedure described in the next section, Configurable Power-Up Method.

Configurable Power-Up Method
With the configurable power-up state feature, you can define the power-up

configuration on a module-by-module basis. You do not need to set any of

the channels to the desired power-up state, as you would with the Snapshot

feature. But you could use the configurable power-up method to adjust

previously stored Snapshot information.
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1. In FieldPoint Explorer right-click on an I/O module and select Edit

this device.

2. Click the Channel Configuration button, then enter any of the

following power-up values for any channel:

• Range, attribute, and output values for each channel

• Network watchdog data value of each channel

• Network watchdog data enabled (or disabled) status for each

channel

• Network watchdog timer enabled (or disabled) status of each

module

• Network watchdog timeout value for the FieldPoint bank

3. Click OK twice.

4. Right-click on the FP-1601 network module in the left pane of

FieldPoint Explorer, and select Edit this device.

5. Deselect the factory configuration checkbox and click OK.

6. Select File»Save.

Inserting, Removing, or Replacing I/O Modules
(HotPnP)

The HotPnP feature simplifies system installation, configuration, and

maintenance. As long as an empty terminal base is already available in the

bank, you can remove or insert I/O modules into the terminal bases, even if

the system is already engaged in network activity. You do not need to

power down the bank or the system. In addition, you do not need to change

the operation of the host computer or software to use the HotPnP feature.

While one or more new or replacement I/O modules in a bank are being

serviced by the HotPnP feature, the other I/O modules in the bank remain

fully operational and accessible on the network without any interruptions.

When you insert an I/O module with the power on, it is automatically

recognized and made available on the network with the appropriate

configuration. To see the new module in FieldPoint Explorer, click Find

Devices in the Comm Resource Configuration dialog box and select

File»Save.

Caution Do not add or remove terminal bases while power is applied to the bank.



Chapter 4 Feature Set Description

FP-1601 User Manual 4-4 ni.com

Commands sent to a missing module return an error response, but the

FP-1601 stores the commands and applies the effects of these commands if

a suitable replacement module is inserted.

When a new I/O module is connected in place of the one that was removed,

the FP-1601 first verifies that the replacement I/O module is compatible

with the one that was removed. If the I/O module is the same as, or is

compatible with the one removed, the FP-1601 configures the replacement

I/O module with the configuration of the previous module and output value

settings.

Table 4-1 shows how modules are configured after HotPnP replacement.

LED Indicators

The FP-1601 has several LEDs to convey status information.

POWER LED
The green POWER LED is lit while the FP-1601 is powered up. This LED

indicates that the power supply connected to the FP-1601 is acceptable, and

that the FP-1601 is supplying power to the I/O modules.

Table 4-1. Module Configuration Results After HotPnP Replacement

Replacement

Module

Start in Factory

Default

Replacement Module

Configuration After HotPnP

Compatible with the removed

module

Either Enabled or

Disabled

Same as the configuration of the

removed module

Incompatible with the removed

module, but compatible with the

stored Snapshot information

Disabled Same as the configuration stored in

the Snapshot

Enabled Factory default configuration of

replacement module

Incompatible with the removed

module and incompatible with the

stored Snapshot information

Either Enabled or

Disabled

Factory default configuration of

replacement module
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STATUS LED
The red STATUS LED is off in normal operation mode. The FP-1601

indicates specific error conditions by flashing STATUS a specific number

of times. Refer to the STATUS LED Error Indications   section of

Appendix C, Troubleshooting, for more information about STATUS LED

error indications.

LINK LED
The green LINK LED is lit when the FP-1601 is connected to a functioning

Ethernet segment.

ACTIVE LED
The green ACTIVE LED is lit when the FP-1601 receives data from or

transmits to the Ethernet. Because of unrelated network activity, this LED

blinks occasionally even when the FP-1601 is inactive.

100 Mbps LED
The yellow 100 Mbps LED is lit when the FP-1601 is communicating at

100 megabits per second. If the 100 Mbps LED does not light, all

communications with the FP-1601 is at 10 megabits per second.

User-Accessible LEDs (A–D)
You can access LEDs A, B, C, and D through the FieldPoint VIs; they are

considered count output channels 7, 8, 9, and 10 on the network module.

LEDs B, C, and D can be sent values of 0, 1, or 2. LED A can be sent only

0 or 1. The values sent to these LEDs manifest as 0=off, 1=green, and

2=red.

Power-On Self Test (POST)
The FP-1601 runs a power-on self test (POST) at power up to verify its own

operational status. The test takes several seconds, does not affect the

operation of the network, and does not affect any of your field wiring

connected to the terminal bases in the bank.

If the power-on self test fails, the FP-1601 does not participate in network

communication, eliminating potential conflicts with the other banks in your

network.

When you power up the FP-1601 successfully for use, the POWER and

STATUS LEDs come on for about 5 seconds, then the STATUS LED
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turns off. When the I/O module READY LEDs come on, the network

module is ready for use.

The FP-1601 indicates POST failure through the STATUS LED. If the

LEDs do not follow the sequence described here, refer to the STATUS

LED Error Indications  section in Appendix C, Troubleshooting, for

information about possible reasons.

DIP Switches

The following illustration shows the switches on the front of the FP-1601.

Switches 1, 2, 3, 4, 5, 6, and 7 are user-accessible DIP switches. They may

be read by the FieldPoint LabVIEW VIs, but have no default functionality.

RESET Switch
The position of the RESET switch determines whether the IP settings of the

FP-1601 network module are reset at power up or reboot. It is necessary to

reset the TCP/IP settings of the module if you are moving it from one

subnet to another, or you suspect the system is inaccessible due to bad

TCP/IP settings. Refer to Appendix B, Resetting the FP-1601, for more

information about the procedure for resetting the FP-1601.
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User-Accessible DIP Switches (1–7)
The user-accessible switches (1–7) can be read from any of the supported

host interfaces, including FieldPoint Explorer, as discrete input channels on

the network module.

Upgrading the Firmware on the FP-1601

To upgrade the firmware on the FP-1601, follow these steps:

1. In FieldPoint Explorer, right-click the FieldPoint icon and select Add

a comm resource to this server.

2. In the Comm Resource Configuration dialog box, select Ethernet as

the Type.

3. Click Browse to launch Remote System Explorer. Right-click the

serial number of the FP-1601 and select Install/Upgrade Software.
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4. In the Upgrade Firmware dialog box, click Browse.

5. In the Open dialog box, navigate to the new .fpf firmware file.

Click Open.

6. After you have selected the new firmware file, in the Upgrade

Firmware dialog box, click Update.
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A
Choosing Network Settings

This appendix describes how to choose appropriate network settings.

Choosing an IP Address

The way you choose an IP address for your FP-1601 depends on whether

your network has a system administrator.

Choosing an IP Address with a Network Administrator
If you are adding the FP-1601 to an existing Ethernet network, you must

choose IP addresses carefully. Consult with your network administrator to

obtain appropriate values:

• Ask the administrator to provide static IP addresses to your FP-1601

and the computer running the National Instruments Time Service.

Time Service is installed along with the FieldPoint software and runs

automatically.

• Ask the network administrator to provide the proper subnet mask,

gateway, and DNS server addresses.

Choosing an IP Address without a Network Administrator
If you are assembling your own small Ethernet network, you can choose

your own IP address. The following guidelines may help you choose

appropriate values:

• IP Addresses are generally in the form of w.x.y.z where w, x, and y

are numbers between 0 and 255 (inclusive) and z is between 1 and 254;

however, a z value of 1 is usually reserved for the IP address of a

gateway.

• Local networks (those that will not be connected to the Internet) should

have IP addresses assigned from the following ranges:

– 10.0.0.0 through 10.255.255.255

– 172.16.0.0 through 172.31.255.255

– 192.168.0.0 through 192.168.255.255
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• To determine whether an IP address is already used by another device

on the network, select Start»Run. Type ping x.x.x.x where

x.x.x.x is the IP address you want to test, and click OK. If ping

returns a timeout, the IP address is not used. If it returns a reply from

a device, the IP address is already in use.

• A subnet is a set of systems whose IP addresses are configured such

that they can communicate directly with one another. Data does not

flow through an intermediate router. The most common subnet mask is

255.255.255.0.

• Appropriate subnet masks should be chosen to divide your system into

smaller subnets, as desired. The method for determining the subnet is

as follows:

The IP Address is combined in a logical AND with the subnet mask to

determine the subnet. For example, a system with an IP address of

10.10.10.10 and a subnet mask of 255.255.255.0 is on the

subnet of 10.10.10.x. Thus, all systems with an IP of 10.10.10.x

and a subnet mask of 255.255.255.0 are considered to be on the

same subnet. Likewise, if the systems had a subnet mask of

255.255.0.0, all systems with an IP of 10.10.x.x are considered

part of the same subnet.

• Using the Suggest Values button when configuring the IP address of a

network module in FieldPoint Explorer should result in values that

work on your network.

• The Time Server is the address of the computer where you have

installed the National Instruments Time Service. This service is

installed along with the FieldPoint software, Lookout 4.0 or later, and

the LabVIEW Datalogging and Supervisory Control module.

• If you are setting up your own network, you probably do not have a

gateway or DNS server, so set these values to 0.0.0.0.

• To find out the network settings for your computer, run winipcfg on

Windows 98/95 or ipconfig on Windows NT/2000.

To run winipcfg, select Start»Run, type winipcfg in the Open

field, and click OK. The IP Configuration window appears, which

gives you information about the network setup for your computer.

Make sure that the correct Ethernet adapter appears in the field at the

top of the window.

To run ipconfig, open a Command window, type ipconfig at the

prompt, and press <Enter>. If you need more information, you can run

ipconfig with the /all option by typing ipconfig /all. Make

sure you use the settings for the correct Ethernet adapter to configure

your FP-1601.
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Identifying Your FP-1601 to the Network

How you identify your FP-1601 to the network depends on if your network

has a DNS server.

• If your network has a DNS server, follow these steps to make sure the

DNS Address value points to the correct location.

a. Right-click the Comm Resource in FieldPoint Explorer, and

choose Edit this comm resource.

b. Click Browse to launch Remote System Explorer.

c. Double-click the serial number of the module for which you want

to verify the DNS address.

d. On the Network Settings tab of the System Configuration dialog

box, make sure the DNS Address value points to the correct

location.

e. Ask your network administrator to add a table entry for your DNS

address.

• If your network does not have a DNS server, you must set up the hosts 

files on each networked computer. A hosts file allows a networked

computer to use host names when no DNS server is available. Each

computer on the network that needs to access the FP-1601 should have

a properly configured hosts file.

Setting up a Hosts File Under Windows NT/2000

1. Log on as an administrator to the local machine (not onto a domain).

2. Create a text file called hosts. Place this file in the

system32\drivers\etc directory of the system root, for example:

c:\winnt\system32\drivers\etc\hosts

3. The file should include the following lines, where hostname is the

host name of the FP-1601 and 12.34.56.78 is its IP address:

127.0.0.1 localhost

12.34.56.78 hostname
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Setting Up a Hosts File Under Windows 98/95

1. Create a text file called hosts. Place this file in the windows

directory, for example c:\windows\hosts

2. The file should include the following lines, where fp is the host name 

of the FP-1601 and 12.34.56.78 is its IP address:

127.0.0.1 localhost

12.34.56.78 fp

Viewing and Editing the FP-1601 TCP/IP Settings

Follow these steps to view the TCP/IP settings:

1. In FieldPoint Explorer, right-click the Comm Resource and select Edit

this comm resource.

2. Click Browse to launch Remote System Explorer.

3. In Remote System Explorer, double-click the serial number of the

FP-1601 whose settings you would like to view or change.

4. When you are done, click OK. Click Cancel to discard any changes

you have made.
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B
Resetting the FP-1601

If the FP-1601 is not able to communicate with the network, you can

manually reset the unit to its factory settings. In this state, you should

always be able to browse for the FP-1601 using Remote System Explorer

if it is on the same physical subnet as your host computer. When you reset

the FP-1601, the following actions occur:

• The IP address, subnet mask, DNS address, gateway, and Time Server

IP are set to 0.0.0.0.

• The normal I/O services are suspended until the FP-1601 is

reconfigured, but I/O module configuration is preserved. (Send a Reset

command in FieldPoint Explorer to reset an individual I/O module.)

• The device appears as Unconfigured in Remote System Explorer.

• The system is unlocked, and any password protection is removed for

configuration settings and data points.

• Resetting does not affect power-up defaults or watchdog settings.

Follow these instructions to reset the unit:

1. Power down the FP-1601.

2. Move the RESET DIP switch on the front of the module to the

ON position, as shown in the following illustration.

3. Power up the FP-1601 and wait for the red STATUS LED to start

flashing. When it flashes, the FP-1601 is in reset mode.

4. Move the RESET switch back to the OFF position.

5. Power down the FP-1601 and power it up again.
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C
Troubleshooting

This appendix gives troubleshooting instructions for the FP-1601 and

FieldPoint software.

Software Configuration Problems

Error when Browsing in Comm Resource Configuration Dialog Box
Possible causes and solutions:

• Your Ethernet adapter is not installed properly. To install your Ethernet

adapter, select Start»Settings»Control Panel and double-click on

Network. Your Ethernet adapter should appear in the list of installed

components. If it does not appear, reinstall the software that came with

your Ethernet adapter. If you do not have this software, contact the

Ethernet adapter manufacturer.

• Your Ethernet adapter is installed, but TCP/IP protocol is not. TCP/IP

is the network protocol used to communicate over Ethernet to the

FP-1601. Select Start»Settings»Control Panel and double-click

Network. TCP/IP should appear in the list of installed network

components. If it does not appear, select Protocol from the Network

Component Type dialog box and click Add. In the Select Network

Protocol dialog box that appears, select Microsoft as the

manufacturer and TCP/IP from the Network protocol list. Click OK.

You may need the Microsoft Windows disks or CD-ROM that came

with your computer, and you may have to restart your computer after

closing the Network control panel.

FP-1601 Does Not Appear in Remote System Explorer Dialog
when Browsing

Possible causes and solutions:

• Verify that there is power to the FP-1601, and that both the module and

the computer are properly connected to the Ethernet network. The

module’s POWER and LINK LED indicators should be lit. When you

click Browse, the ACTIVE LED on the FP-1601 should flash to

indicate that communications are taking place.
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• Certain network devices, such as switches and routers, can filter out the

directed UDP broadcast packets that FieldPoint Explorer uses to

communicate with unconfigured FP-1601 modules, even if they are on

the same subnet as the computer running FieldPoint Explorer. You can

test this by connecting the computer running FieldPoint Explorer and

the FP-1601 directly to a simple Ethernet hub or by using a crossover

cable between the FP-1601 and the host PC. If the FP-1601 appears in

the Remote System Explorer window using this configuration, but not

when connected to the larger network, it is likely that there is a

problem of this type. Consult your network administrator.

• The FP-1601 may have been configured on another network and then

moved to the current network. Refer to Appendix B, Resetting the

FP-1601, for instructions on resetting the FP-1601.

• You may be using the wrong type of Ethernet cable.

• You may have assigned an IP address to your FP-1601 that is already

used by another device on the network. Either remove or reconfigure

the other device, or reconfigure the FP-1601 IP address. Refer to

Appendix A, Choosing Network Settings, for information on choosing

IP settings.

Error when Configuring IP Settings for the FP-1601
Possible causes and solutions: Make sure you are entering valid values for

all network parameters. If the subnet mask or IP address is not compatible

with the network settings, an error is returned and the FP-1601 will not be

configured.

FP-1601 Returns Invalid Timestamp Values
Possible causes and solutions:

• Verify that the IP address entered in Remote System Explorer points to

a computer running National Instruments Time Service.

• Verify that the time zone settings are set correctly on the host PC and

Time Server PC.

• Verify that National Instruments Time Service was installed on the

computer you have specified as the Time Server. If Time Service is

installed but is not running, restart it either using the Service Manager

or using the following commands.

– Under Windows Me/98/95—Open an MS-DOS prompt and

enter c:\windows\system\lktsrv -start

or right-click the lighthouse icon in the PC’s system task tray.



Appendix C Troubleshooting

© National Instruments Corporation C-3 FP-1601 User Manual

– Under Windows NT/2000—Open a Command Prompt and

enter c:\winnt\system32\lktsrv -start

or use the Services Manager available through the Control Panel.

If Time Service is not installed, refer to Chapter 2, Hardware and

Software Installation, for instructions on installing the FieldPoint

software, which includes Time Services.

No Modules Found Error in FieldPoint Explorer
Possible causes and solutions:

• Make sure that the FieldPoint hardware is powered on. Make sure

terminal bases are firmly mated, I/O modules are firmly seated on the

terminal bases, and the cable connections are secure. The I/O module

READY LEDs should be lit if all these connections are good.

• You may have assigned an IP address to your FP-1601 that is already

used by another device on the network. Either remove or reconfigure

the other device, or reconfigure the FP-1601 IP address. Refer to

Appendix A, Choosing Network Settings, for information on choosing

IP settings.

• The timeout value might be too small. Increase it and try again.

STATUS LED Error Indications

The FP-1601 indicates specific error conditions by flashing the red

STATUS LED a specific number of times. The following table describes

the STATUS LED flashing sequences and the corresponding error

condition.

Table C-1. STATUS LED Flashes and Corresponding Error Conditions

Number

of Flashes Error Condition

0 (stays lit) The FP-1601 did not power on correctly.

Contact National Instruments for assistance.

1 The FP-1601 is in reset mode or is unconfigured.

Refer to Appendix B, Resetting the FP-1601, for more

information about reset mode. Refer to Chapter 3,

Hardware and Software Configuration, for more

information about configuration.
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2 The FP-1601 has detected an error in its firmware. This

usually occurs when an attempt to upgrade the firmware

is interrupted. Repeat the firmware upgrade process.

3 (or more) The FP-1601 has detected an unrecoverable error.

Contact National Instruments for assistance.

Table C-1. STATUS LED Flashes and Corresponding Error Conditions (Continued)

Number

of Flashes Error Condition
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D
Specifications

Installation
Terminal wiring...................................... 16-26 AWG copper conductor

wire with 7 mm (0.275 in) strip

length

Torque for screw terminals .................... 0.5-0.6 Nm (4.4-5.3 in-lbs)

Network
Network interface................................... 10BaseT and 100BaseTX

Ethernet

Compatibility ......................................... IEEE802.3

Communication rates ............................. 10 Mbps, 100 Mbps,

autonegotiated

Maximum cabling distance .................... 100 m/segment (328 ft/segment)

Power supply range................................ 12 to 30 VDC

Power consumption................................ 4.5 watts + 1.1 * ∑(I/O Module

Consumption)

Maximum terminal bases per bank ........ 9

Maximum number of banks ................... determined by network topology

Weight .................................................... 235 g (8.3 oz)

Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the

common-mode voltage.

Channel-to-earth..................................... 250 V, Installation Category II

Channel-to-channel ................................ 0 V
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Environmental
FieldPoint modules are intended for indoor use only.

Operating temperature ............................–25 to +55 °C

Storage temperature ................................–40 to +85 °C

Humidity .................................................10% to 90% RH, noncondensing

Maximum altitude...................................2,000 m (6,560 ft)

Pollution Degree ....................................2

Safety
The FP-1601 meets the requirements of the following standards for safety

and electrical equipment for measurement, control, and laboratory use:

• EN 61010-1:1993/A2:1995, IEC 61010-1:1990/A2:1995

• UL 3101-1:1993, UL 3111-1:1994, UL 3121:1998

• CAN/CSA c22.2 no. 1010.1:1992/A2:1997

Electromagnetic Compatibility
CE, C-Tick and FCC Part 15 (Class A) Compliant

Electrical emissions ................................EN 55011 Class A at 10 m FCC

Part 15A above 1 GHz

Electrical immunity ................................Evaluated to EN 61326: 1997/A1:

1998, Table 1

Note For full EMC compliance, you must operate this device with shielded cabling. See

the Declaration of Conformity (DoC) for this product for any additional regulatory

compliance information. To obtain the DoC for this product, click Declaration of

Conformity at ni.com/hardref.nsf/.
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Cabling
The following table shows the standard Ethernet cable wiring connections

for both normal and crossover cables.

The following illustration shows the connector pinouts for FieldPoint

Ethernet cables.

Table D-1. Ethernet Cable Wiring Connections

Pin Connector 1

Connector 2

(Normal)

Connector 2

(Crossover)

1 white/orange white/orange white/green

2 orange orange green

3 white/green white/green white/orange

4 blue blue blue

5 white/blue white/blue white/blue

6 green green orange

7 white/brown white/brown white/brown

8 brown brown brown

Connector 1 Connector 2

pin 1 pin 1 pin 8pin 8
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E
Technical Support and
Professional Services

Visit the following sections of the National Instruments Web site at

ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions,

visit our extensive library of technical support resources available

in English, Japanese, and Spanish at ni.com/support. These

resources are available for most products at no cost to registered

users and include software drivers and updates, a KnowledgeBase,

product manuals, step-by-step troubleshooting wizards,

conformity documentation, example code, tutorials and

application notes, instrument drivers, discussion forums, a

measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other

measurement and automation professionals by visiting ni.com/

support. Our online system helps you define your question and

connects you to the experts by phone, discussion forum, or email.

• Training—Visit ni.com/custed for self-paced tutorials, videos, and

interactive CDs. You can also register for instructor-led, hands-on

courses at locations around the world.

• System Integration—If you have time constraints, limited in-house

technical resources, or other project challenges, NI Alliance Program

members can help. To learn more, call your local NI office or visit

ni.com/alliance.

• Declaration of Conformity (DoC)—A DoC is our claim of

compliance with the Council of the European Communities using the

manufacturer’s declaration of conformity. This system affords the user

protection for electronic compatibility (EMC) and product safety. You

can obtain the DoC for your product by visiting ni.com/hardref.nsf.
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• Calibration Certificate—If your product supports calibration, you

can obtain the calibration certificate for your product at ni.com/

calibration.

If you searched ni.com and could not find the answers you need, contact

your local office or NI corporate headquarters. Phone numbers for our

worldwide offices are listed at the front of this manual. You also can visit

the Worldwide Offices section of ni.com/niglobal to access the branch

office Web sites, which provide up-to-date contact information, support

phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

m milli 10–3

M mega 106

% percent.

° degrees.

bank The combination of one FieldPoint network module and one or more

terminal bases and I/O modules.

C Celsius.

DIP switch Dual Inline Package switch.

DNS Domain Name System.

FTP File Transfer Protocol.

HotPnP Hot Plug and Play.

IEC International Electrotechnical Commission.

I/O Input/Output.

LED Light-emitting diode.

m meters.

OPC OLE for Process Control.

POST Power-On Self Test.

V Volts.

VDC Volts direct current.
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Index

Numerics
100 Mbps LED, 4-5

A
A LED, 4-5

access permissions, 3-11

Active LED, 4-5

B
B LED, 4-5

battery-backed internal clock, 3-4

C
C LED, 4-5

cables

Ethernet, 2-10, 2-11, D-3

calibration certificate, E-2

channels

attributes, 3-8

configuration, 3-7

deadband, 3-8

monitoring, 3-12

output values, 3-8

range, 3-8

type, 3-8

writing to an output, 3-13

cleaning your FP-1601, 2-2

Comm Resource configuration, 3-1, 3-11

troubleshooting browse errors, C-1

configuration

channel configuration, 3-7

Comm Resource configuration, 3-1,

3-11, C-1

connecting to field devices, 2-13

custom power-up configuration, 4-2

devices and channels, 3-5

HotPnP (Hot Plug and Play), 4-3

overview, 1-4

saving hardware configuration as power-up

state, 3-9

software configuration in FieldPoint

Explorer, 3-1

troubleshooting software configuration

problems, C-1

verification, 3-12

contacting National Instruments, E-2

conventions used in the manual, iv

customer

education, E-1

professional services, E-1

technical support, E-1

D
D LED, 4-5

data communication

100 Mbps LED, 4-5

Declaration of Conformity, E-1

diagnostic resources, E-1

DIN rail mount. See installation, mounting

hardware on DIN rail

DIP switches, 4-6

DNS address

choosing values, A-1

configuring, 3-3

resetting with Reset switch, B-1

documentation

online library, E-1

drivers

instrument, E-1

software, E-1
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E
errors

I/O status shown in FieldPoint

Explorer, 3-12

Status LED, 4-5

Status LED error indications (table), C-3

troubleshooting software configuration

problems, C-1

Ethernet network

cable length (caution), 2-10

cabling connections (table), D-3

connecting FP-1601 to network, 2-10

connections

Active LED indicator, 4-5

illustration, 1-3

Link LED indicator, 4-5

methods, 2-11

example code, E-1

F
factory configuration, 3-9

FieldPoint bank (definition), 1-2

FieldPoint Explorer

configuring devices and channels, 3-5

configuring the FP-1601, 3-1

installation, 2-14

monitoring I/O channels, 3-12

saving configuration as power-up

state, 3-9

troubleshooting No Modules Found, C-3

verifying configuration, 3-12

writing to an output channel, 3-13

FieldPoint safety information, 2-1

FieldPoint software

See also FieldPoint Explorer; Remote

System Explorer

FTP download site, 1-3

installation, 2-14

OPC server, 3-17

overview, 1-3

FieldPoint VIs, 3-15, 4-7

FP-1601, 1-1

FP-1601 hardware

comment to identify FP-1601, 3-4

configurable power-up state, 4-2

configuration in FieldPoint Explorer, 3-1

connecting to network, 2-10

DIP switches, 4-6

feature set, 4-1

HotPnP (Hot Plug and Play), 4-3

identifying your FP-1601 to the

network, A-3

installation

connecting to network, 2-10

mounting FP-1601 on DIN rail, 2-4

mounting FP-1601 to panel, 2-6

IP address, 3-3, A-1

network watchdog, 4-1

power supply to I/O modules, 2-13

powering, 2-11

powering (figure), 2-12

powering up, 2-13

resetting to factory settings, B-1

saving configuration as power-up

state, 3-9

security settings, 3-11

setup overview, 1-4

snapshot feature, 4-2

specifications, D-1

TCP/IP settings, A-4

using with host PC software

LabVIEW, 3-15

LabWindows/CVI, 3-16

Lookout, 3-14

OPC server, 3-17

overview, 3-14

FP-2000/2010 hardware

safety information, 2-1

FTP, National Instruments FTP site, 1-3



Index

© National Instruments Corporation I-3 FP-1601 User Manual

G
gateway IP address

choosing values, A-1

configuring, 3-3

resetting with Reset switch, B-1

H
help

professional services, E-1

technical support, E-1

host access, limiting, 3-11

Hosts files

Windows 98/95, A-4

Windows NT/2000, A-3

HotPnP (Hot Plug and Play)

I/O module configuration after HotPnP

replacement (table), 4-4

overview, 4-3

I
I/O modules

configurable power-up state, 4-2

configuration, 3-5

configuration after HotPnP replacement

(table), 4-4

connecting to field devices, 2-13

inserting, 4-3

monitoring channels, 3-12

mounting on terminal bases, 2-9

No Modules Found error, C-3

powering, 2-11

removing, 2-10, 4-3

replacing, 4-3

resetting, B-1

saving configuration as power-up

state, 3-9

writing to an output channel, 3-13

icon, 3-10, 3-12, 3-13

installation

category, 2-2

connecting to network, 2-10

FieldPoint software, 2-14

HotPnP (Hot Plug and Play), 4-3

mounting hardware on DIN rail

connecting terminal bases, 2-5

mounting FP-1601, 2-4

removing FP-1601 and terminal

bases, 2-6

mounting hardware to a panel

connecting terminal bases, 2-8

FP-1601 mounting procedure, 2-6

panel mount accessory, 2-6, 2-8

panel mount accessory (figure), 2-7

removing FP-1601 and terminal

bases, 2-9

mounting I/O modules onto terminal

bases, 2-9

overview, 1-4

power connections, 2-11, 2-13

power connections (figure), 2-12

removing I/O modules, 2-10

instrument drivers, E-1

IP Access List, 3-11, 3-12

IP address

See also gateway IP address; DNS

address; time server; subnet mask

choosing, A-1

configuring, 3-3

error when configuring, C-2

resetting with Reset switch, 4-6, B-1

IP Pattern, 3-11

isolation

defeated by cascading power

(caution), 2-12

defeated by cascading power

(figure), 2-12
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K
KnowledgeBase, E-1

L
LabVIEW VIs

FieldPoint VIs, 3-15

LabVIEW FieldPoint VIs, 4-7

LabWindows/CVI software, 3-16

LED indicators, 4-4

power-on self test (POST), 2-13, 4-5

Link LED, 4-5

local bus connector

protective cover (figure), 2-6, 2-9

Lookout software, 3-14

M
100 Mbps LED, 4-5

modules. See FP-1601 hardware; I/O modules

monitoring I/O channels, 3-12

mounting hardware on DIN rail. See

installation, mounting hardware on DIN rail

mounting hardware to a panel. See installation,

mounting hardware to a panel

N
National Instruments

calibration certificate, E-2

customer education, E-1

Declaration of Conformity, E-1

professional services, E-1

system integration services, E-1

technical support, E-1

worldwide offices, E-2

network module. See FP-1601 hardware

network security settings, 3-11

network watchdog, 4-1

network. See Ethernet network

O
online technical support, E-1

OPC client, 3-17, 3-18

OPC server, 3-17, 3-18

overview

FieldPoint software, 1-3

FP-1601 hardware, 1-1

setup, 1-4

using FP-1601 from host

applications, 3-14

P
panel mount. See installation, mounting

hardware to a panel

password-protected resets, B-1

phone technical support, E-2

pollution degree, 2-2

power connections

calculating power for FieldPoint

bank, 2-13

illustration, 2-12

wiring, 2-11

Power LED, 4-4

power supply, 2-11

power-on self test (POST), 2-13, 4-5

power-up

overview, 2-13

power-up state, configurable, 4-2

professional services, E-1

programming examples, E-1

R
rail clip, 2-4, 2-6

registering computers

with Lookout, 3-14

with OPC, 3-17

Remote System Explorer

features and options, 3-10

troubleshooting browse errors, C-1
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removing FP-1601 and terminal bases

DIN rail mount, 2-6

panel mount, 2-9

Reset switch, 4-6, B-1

resetting a FieldPoint bank, 4-6, B-1

S
safety information, 2-1

saving current state of FieldPoint bank, 4-2

security

network security settings, 3-11

snapshot feature, 3-9, 4-2

software drivers, E-1

specifications, D-1

Status LED, 4-5

Status LED error indications (table), C-3

subnet mask

choosing values, A-1

configuring, 3-3

resetting with Reset switch, B-1

support

technical, E-1

switches

DIP switches, 4-6

DIP switches 1 through 7, 4-7

system integration services, E-1

T
TCP/IP settings, A-4

technical support, E-1

telephone technical support, E-2

terminal bases

connecting with DIN rail mount, 2-5

connecting with panel mount, 2-8

powering, 2-11, 2-12

removing with DIN rail mount, 2-6

removing with panel mount, 2-9

testing

power-on self test (POST), 4-5

verifying configuration in FieldPoint

Explorer, 3-12

time server

choosing IP address, A-1

configuring IP address, 3-4

resetting with Reset switch, B-1

timestamp

shown in FieldPoint Explorer, 3-12

troubleshooting invalid values, C-2

training

customer, E-1

troubleshooting

Comm Resource Configuration dialog

box errors, C-1

invalid timestamp values, C-2

IP configuration errors, C-2

No Modules Found error, C-3

Remote System Explorer browse

errors, C-1

Status LED error indications (table), C-3

troubleshooting resources, E-1

V
VIs. See LabVIEW VIs

W
watchdog, 4-1

Web

professional services, E-1

technical support, E-1

wiring

Ethernet cables, D-3

Ethernet connections, 2-11

field devices, 2-13

power, 2-11

power (figure), 2-12

worldwide technical support, E-2

writing to an output channel, 3-13
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